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Welcome to Sign Wizard 7  

Sign Wizard 7 represents a major step forward for sign designers and 

ƎǊŀǇƘƛŎ ŀǊǘƛǎǘǎ ǿƘƻ ǿŀƴǘ ǘƻ Řƻ ƳƻǊŜ ƛƴ ƭŜǎǎ ǘƛƳŜΦ LŦ ȅƻǳ ŀǊŜ ŀ ƭƻƴƎ ǘƛƳŜ {ƛƎƴ ²ƛȊŀǊŘ ǳǎŜǊΣ ȅƻǳΩƭƭ 

appreciate the many new features and capabilities that are consistent with what the software has 

always delivered: powerful capabilities that are easy to use.  

LŦ ȅƻǳ ŀǊŜ ŀ ōǊŀƴŘ ƴŜǿ ƻǊ ǊŜƭŀǘƛǾŜƭȅ ƴŜǿ ǳǎŜǊΣ ȅƻǳΩƭƭ ōŜ ŀƳŀȊŜŘ ŀǘ ŀƭƭ ǘƘŀǘ ǘƘƛǎ ǎƻŦǘǿŀǊŜ Ŏŀƴ ŘƻΣ ŀƭƭ ǘƘŜ 

various combinations of capabilities that go into making some of the examples in this guide. 

 

!ǎ ǿŜ ǿƻǊƪ ǘƘǊƻǳƎƘ ǘƘƛǎ ƎǳƛŘŜΣ ȅƻǳΩƭƭ ƴƻǘƛŎŜ ǘƘŀǘ ǿƘƛƭŜ ǘƘŜ ŦƻŎǳǎ ƛǎ ƻƴ ǘƘŜ ƴŜǿ ŦŜŀǘǳǊŜǎ ƛƴ ǾŜǊǎƛƻƴ тΣ ǿŜ 

also cover how they integrate or augment existing features to deliver new design capabilities. Some 

prior knowledge of Sign Wizard is assumed, and if you get lost at any point, please access the Online 

Help. 

 

One important set of improvements in version 7 is the underlying text engine, which has been 

dramatically enhanced, especially for large amounts of text. Sign Wizard has always been very strong 

with text editing, and this continues with lots of new capabilities. Some of the other new features are 

ŀŎǘǳŀƭƭȅ ŜƴŀōƭŜŘ ǿƛǘƘ ǘƘƛǎ ƴŜǿ ǘŜȄǘ ŜƴƎƛƴŜΦ ¸ƻǳΩƭƭ ōŜ ŀƳŀȊŜŘ ŀǘ Ƙƻǿ ŦŀǊ ȅƻǳ Ŏŀƴ Ǝƻ ǿƛǘƘ ŀ ŘŜǎƛƎƴΣ ŀƴŘ 

then go back and change the font or change the copy. 

 

!ƴƻǘƘŜǊ ŦƻŎǳǎ ƻŦ ǘƘƛǎ ǊŜƭŜŀǎŜ Ƙŀǎ ōŜŜƴ ƻƴ άŘȅƴŀƳƛŎέ ŜŦŦŜŎǘǎ ŀƴŘ ŦǳƴŎǘƛƻƴǎ ǘƘŀǘ ƘŀǾŜ ǎƻƳŜ άƳŜƳƻǊȅΦέ 

This means that you can create an Effect, or perhaps several Effects, and still go back into the settings 

ŀƴŘ ŀŘƧǳǎǘ ǘƘŜƳ ƭŀǘŜǊΦ bƻǘƘƛƴƎ ƛǎ ǎŜǘ ƛƴ ǎǘƻƴŜΣ ŀƴŘ ŀǎ ŀ ǊŜǎǳƭǘΣ ǘƘŜ ŘŜǎƛƎƴ ǇǊƻŎŜǎǎ ƛǎ ƳƻǊŜ άƴƻƴ-ƭƛƴŜŀǊΦέ 

¢ƘŜ ǇŀǊǘƛŎǳƭŀǊ ƻǊŘŜǊ ƻŦ ǎǘŜǇǎ ƛƴ ǘƘŜ ŘŜǎƛƎƴ ŘƻŜǎƴΩǘ ƳŀǘǘŜǊ ŀǎ ƳǳŎƘ ŀƴȅƳƻǊŜΣ ǎƻ ǘƘŀǘ ȅƻǳ Ŏŀƴ ŜȄǇŜǊƛƳŜƴǘ 

with fresh ideas and mix things up a bit. 

 

Another tangent with version 7 is that of libraries for design elements that can be accessed at any time 

to augment your designs. There are libraries for Effects and for Image Fills that let you save your 

favorites for future use. The items in the Effects Library can incorporate several Design elements, saving 

you many steps should you decide to use them again in the future. The Image Fills library lets you save 

and categorize bitmaps that you can use as fills for text and graphics, such as gold leaf, various textures, 
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ǊŜǇŜŀǘƛƴƎ ǇŀǘǘŜǊƴǎΣ ŜǘŎΦ ¢Ƙƛǎ ƛǎ ŎƻƴǎƛǎǘŜƴǘ ǿƛǘƘ ǿƘŀǘ ǿŜΩǾŜ ŘƻƴŜ ǿƛǘƘ .ƭŜƴŘǎΣ ²ŀǊǇΣ ŀƴŘ ƻǘƘŜǊ ŦŜŀǘǳǊŜǎΣ 

but to a new level. 

 

The management and editing of bitmap images has also been a focus of this release. The Brush Tool, the 

Eraser Tool, and the Clone Stamp Tool are new, giving you additional ways to edit your bitmaps for 

situations like removing an existing sign in a picture and replacing it with yours! 

 

The new Dynamic Contour Cut Path feature makes it easy to create a cut path for a print and cut output, 

and the path will update as you make changes to the design or even add new elements to it. There is 

also a new feature for creating a cut path around an irregularly shaped bitmap. 

 

Sign Wizard 7 has a unique set of abilities for both vector and bitmap images, enabling you to include 

both types of graphics in the same designs for increased creativity. In fact, much of the power in the 

software comes in the ability to handle both bitmap and vector graphics with rich features that can add 

up to more than the sum of the parts. For example, the new Easy Bevel tool starts with a line of text that 

is vector-based and adds highlights and shadows to give it depth, a bitmap-based feature. Then you can 

add a Soft Shadow to separate it from the background, and add a Contour Cut path tightly around the 

object for your print/cut enabled machine. 

 

Never before has so much design power been available to the sign industry. Sign Wizard 7 is at your 

disposal, what will you create? 

  



 Installation and Basics с 

Installation and Basics 

If you are installing from a Sign Wizard 7 disk, put the disk in your CD/DVD drive on your computer.  

Depending on your operating system, security software, and other variables, you may be asked if you 

want to continue. Click Yes ƻǊ /ƻƴǘƛƴǳŜΦ ¸ƻǳǊ ǎȅǎǘŜƳ Ƴŀȅ ŀǳǘƻƳŀǘƛŎŀƭƭȅ Ǌǳƴ ǘƘŜ άǎŜǘǳǇΦŜȄŜέ ŦƛƭŜΣ ƛƴ 

which case this ǎŜǘǳǇ ǎŎǊŜŜƴ ǿƛƭƭ ŀǇǇŜŀǊΦ LŦ ǘƘƛǎ ŘƻŜǎ ƴƻǘ ƘŀǇǇŜƴΣ ǘƘŜƴ ȅƻǳ Ƴǳǎǘ Ǌǳƴ ǘƘŜ άǎŜǘǳǇΦŜȄŜέ ŦƛƭŜ 

on the CD to install the program. 

If this is your initial installation of Sign 

Wizard, and you do not also have a current 

version of Sign Wizard and/or Neon Wizard 

installed on your system with a USB Key, 

then you must install the Key Driver. First 

place the USB Key in an available USB port 

on your computer, and then click on 

Install/Check Key.  

 

If you get this message, ǘƘŜƴ ȅƻǳΩǊŜ ŀƭƭ ǎŜǘΦ 

Otherwise, remove the key, follow the 

directions for installing the driver, then 

reattach the key. 

You can also Browse this CD if you are looking for something particular on the disk, but otherwise you 

need to click on Install Sign Wizard. This will launch the Sign Wizard 7 Installer. 

If you are installing from a downloaded file from the Aries Graphics web site, the exact procedure will 

depend on your operating system, browser, and security software. You may be asked if you trust the 

company and if you want to continue, so click Yes or Continue to these questions. The downloaded file 

ǿƛƭƭ ōŜ ǎƛƴƎƭŜ άΦŜȄŜέ ŦƛƭŜ, and these types of files are sometimes flagged as άsuspiciousέ ōȅ ǎƻƳŜ 
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browsers when downloaded from the internet. When you run this file, you will be presented with this 

Sign Wizard 7 Installer. From here on, the installation from a disk and from a download are the same. 

 

For your initial installation, this is what the Installer will look like. You can change the Installation Folder 

to another location on your computer just by typing in the path of the location you prefer. ¢ƘŜ άŘŜŦŀǳƭǘ 

ǇŀǘƘέ ƛǎ C:\ Sign Wizard 7. The buttons Install Clipart, Install Fonts, Install Program, and Fresh Install will 

automatically be checked. Click on Install to continue. 

If you are installing an Update, meaning that you already have a prior version of Sign Wizard 7 installed 

on your computer, then the following dialog box will appear instead. You have to install the update over 

your current installation, so keep the Installation Folder the same as your current folder. 
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You cannot install into Program Files in Vista or later because Sign Wizard modifies data files in its 

program folder, which is no longer permitted. 

At the end of the installation, you will be asked if you want to run Sign Wizard 7 now. Click on Yes and 

the program will launch. 
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Sign Wizard Layout Window Overview  

This is how the screen will look when you first run Sign Wizard 7 after installing: 

 

²ŜΩƭƭ first do a quick overview of the main sections of the program. The first thing to notice is the 

Workspace, which is outlined with a dotted line. ¢ƘŜ ŘŜŦŀǳƭǘ ǿƻǊƪǎǇŀŎŜ ƛǎ олέ ǿƛŘŜ ōȅ нлέ ǘŀƭƭ όǎŜŜ 

below for information on working in Metric units). This area can be resized by clicking and dragging on 

one of those dotted lines. Try to keep your designs within the workspace, although you are allowed to 

work outside the dotted lines.  

Along the left of the screen is the Toolbox ƻŦ ƛŎƻƴǎΣ ǿƘƛŎƘ Ŏŀƴ ōŜ ŎǳǎǘƻƳƛȊŜŘ ǘƻ ȅƻǳǊ ƭƛƪƛƴƎΦ LŦ ȅƻǳ ŘƻƴΩǘ 

ƪƴƻǿ ǿƘŀǘ ŀƴ ƛŎƻƴ ŘƻŜǎΣ ƘƻǾŜǊ ǘƘŜ ƳƻǳǎŜ ƻǾŜǊ ƛǘ ŀƴŘ ŀ άTool Tipέ ǿƛƭƭ ŀǇǇŜŀǊΦ On the right side of the 

screen, we have the various Tabs, including Color, Effects, and Neon at the top, and then Layers, History, 

and Job at the bottom. You can switch which tab is visible by clicking on the name at the top. 

At the far right of the screen is the Color Palette, which lets you add color to your objects. 
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At the very top of the screen, we have the drop-down menus, such as File, Edit, View, etc. Some of these 

menu items have sub-menus (indicated with an arrow) with additional options. (We will use the 

convention άMenu | Commandέ when describing where to find features in the menus.) Below the 

menus are a set of Icons that are customizable. Below these icons is the standard Text Property Bar, 

which will display information when a text object is selected. Finally, at the very bottom of the screen is 

the Help Bar, which will display instructions and options depending on what you are doing in the 

software. It is a very good idea to keep an eye on this Help bar if you are unsure of what to do next! 

If you are working in Metric units, you can change the Units of Measure in Tools |OptionsΣ άDŜƴŜǊŀƭέ 

tab to either mm or cm. Please noteΥ ƴƻǘ ŜǾŜǊȅ ǾŀƭǳŜ ƛǎ ŘƛǎǇƭŀȅŜŘ ǿƛǘƘ άƳƳέ ƻǊ άƛƴΣέ ŦƻǊ ŜȄŀƳǇƭŜΣ ǎƻ 

please remember which unit of measure you have selected! 
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Sign Wizard Basics 

Here is a quick overview of the basic operation of the software. These descriptions are common to all 

levels of Sign Wizard; more advanced options will be covered below. 

Zooming  and Scrolling  

There is one global function that we should mention first, and if you are a previous Sign Wizard, Neon 

Wizard, or LED Wizard user, you know all about it: using the right mouse button exclusively for Zooming. 

To Zoom In, draw a box around what you want to see closer with the right mouse button. To Zoom Out, 

hold the mouse still and click once with the right mouse button. The right mouse button is only used for 

this purpose, across all functions and modes. There is no mode or icon to click for zooming. 

You can, if you prefer, also zoom with the mouse wheel, or use the various options in View Menu|Zoom. 

Once you are zoomed in, try the Spacebar to scroll. When you are holding the Spacebar, you can move 

the mouse and the screen will scroll. As soon as you release the Spacebar, the scrolling will stop. 

Another option for scrolling is the scroll bars that appear at the bottom and left of the work area. 

Text Entry and Editing  

There are two modes for direct text entry into the layout window: Basic Text and Paragraph Text. We 

will cover Basic Text here, as Paragraph Text is covered in detail later in this document. 

To enter text, click on the Text Icon , select the Font from the drop down list, and then click in the 

layout window and begin typing. When you are finished typing, click on the Layout Tool  and a 

series of control points will appear around the text. 
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You may be familiar with these kinds of control points, but Sign Wizard has a few extra options that you 

might not be aware of or normally see. Experiment with these so that you can see how easy it is to edit 

the text. 

Top Left and Top Right = Scale (Proportionally) 

Middle Left and Middle Right = Extend/Condense 

Top Center = Italicize 

Bottom Center = Rotate 

Bottom Left and Bottom Right = Letter Kerning/Spacing (Uniform) 

Below and Right of each Letter = Individual Letter Kerning 

With the SHIFT key, there are a few more options: 

SHIFT+Top Left/Top Right = Heighten 

SHIFT+Bottom Middle = Arc Text 

SHIFT+Middle Left/Middle Right = Vertical Shear 

SHIFT+Lower Left/Lower Right = Word Spacing 

In addition to these options for graphically editing the text, you can also numerically edit the text using 

the Text Property Bar along the top of the screen: 

 

Note here that the numerical values for this text are displayed. When you move the mouse over each 

field, the Tool Tip will tell you what the value defines. The pertinent data is Letter Spacing -3%, Word 

Spacing at 80% of normal, and Italization at 10%. 
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The Layout Tool  

We briefly mentioned the Layout Tool  ŀōƻǾŜ ŀƴŘ ǿŜΩƭƭ ŜȄǇŀƴŘ ƻƴ ƛǘ ƘŜǊŜΦ ¢Ƙƛǎ ƛǎ ǘhe main operating 

tool in Sign Wizard 7, located at the top of the toolbox on the left. When this tool is selected, you are in 

Layout Mode, and you can Select objects, Move them, Scale them, Group them, and Combine them, 

among many other tasks. This is the default mode when you start the program. When you click on an 

object, you will see control points around the outside. These control points are not limited to text as 

described above, but any object will have control points. Obviously not all functions will be available 

with all objects. 

You can also make a Group by selecting multiple objects.  

Just draw a box with the left mouse button around all the 

objects you want to include in the Group. Groups can be 

nested, meaning a Group can be comprised of other 

Groups. You can Ungroup to manage each object 

individually. 

To make a permanent object, use Combine instead. 

The Vector Edit Tool  

Sign Wizard has a rich set of tools for editing the vectors/nodes that make up all objects. When you 

select the Vector Edit Tool Σ ȅƻǳΩƭƭ ǎŜŜ ǘƘŜ ƛƴŘƛǾƛŘǳŀƭ ǾŜŎǘƻǊǎ ǘƘŀǘ define the object. A vector can 

either be an arc, a line, or a Bezier curve, and there are tools to convert between any of these. A node, 

or a point, is the end of one vector and the beginning of another one. If the two vectors are tangent, 

ǘƘŜƴ ǘƘŜ Ǉƻƛƴǘ ǿƛƭƭ ƘŀǾŜ ŀ Ǉƭǳǎ άҌέ ǎƛƎƴΣ otherwise it will have a black square. 
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To edit the vectors or nodes, you can simply click and drag on a vector or node to move it. If you want to 

move a selection of vectors/nodes, hold the SHIFT key and draw a box around what you want to make 

the selection, and then move it. If you want to Delete a point or a selection of points, simply draw a box 

around the point or points with the left mouse button. 

For other vector editing options, double click and hold the left mouse button to bring up this menu. 

Here you can Insert a point, convert a 

vector to a Line, Arc, or Bezier curve, 

Break the Loop open, Set the Start/End 

Point to that position, Join a Start/End 

Point, or Delete the vector. 

Please also note the shortcut keys to 

the right of the function. Knowing 

these will speed up this kind of vector 

editing! 

Images and the Image Menu 

Much will be covered in this document about working with image files, so this will just be an 

ƛƴǘǊƻŘǳŎǘƛƻƴΦ ¢ƘŜǊŜ ŀǊŜ Ƴŀƴȅ ǘŜǊƳǎ ǳǎŜŘ ŦƻǊ ǘƘƛǎ ƪƛƴŘ ƻŦ ŦƛƭŜΣ ƛƴŎƭǳŘƛƴƎ άǊŀǎǘŜǊΣέ άōƛǘƳŀǇΣέ ŀƴŘ άǇƛȄŜƭΦέ 

Common file formats include JPG, TIFF, PSD, PCX, BMP, GIF, and others. These files contain pixel data, 

which are very small shapes with a color, ŀƴŘ ŀǊŜ ƻŦǘŜƴ ŘŜǎŎǊƛōŜŘ ƛƴ άǇƛȄŜƭ ŘƛƳŜƴǎƛƻƴǎΣέ ǎǳŎƘ ŀǎ 

3000x2000 pixels. It is common for bitmap files to have a DPI (dots per inch), or more accurately, PPI 

(pixels per inch) of 300 if the file is for printing, and 72 if the file is for online display. 

Sign Wizard 7 can create and import/export bitmap files, and use them alongside vector files to create 

some exciting effects. When you have a bitmap file selected, the property bar changes to display 

information about the file. 
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This particular bitmap has pixel dimensions of 2352x1160 and is 32.67 inches wide by 16.11 inches tall at 

72 DPI. Basic operations on bitmaps include Scaling, Cropping, Rotating, and Flipping. Depending on the 

Sign Wizard level, many additional options are available. 

Printing and Plotting  

Depending on your design and the mix of vector graphics and bitmap graphics, when it comes time to 

produce your work, you will either be sending the data to a plotter/vinyl cutter, a printer/large format 

printer, or both.  

IŜǊŜ ǿŜΩƭƭ ŘƛǎŎǳǎǎ ǘƘŜ {ƛƎƴ ²ƛȊŀǊŘ tƭƻǘ aŀƴŀƎŜǊΣ ōŜŎŀǳǎŜ ƛǘ ƛǎ ŎƻƳƳƻƴ ǘƻ ŀƭƭ ƭŜǾŜƭǎ ƻŦ {ƛƎƴ ²ƛȊŀǊŘΦ 

When you are ready to plot or cut your file, select what you want to output and click on the Plot 

Manager icon  or use the shortcut key F2. 

This will launch the Plot Manager and bring in your design. Lƴ ǘƘƛǎ ŜȄŀƳǇƭŜΣ ǿŜ ƘŀǾŜ ǘƘŜ ǘŜȄǘ ά/¦¢έ ƛƴ 

blue vinyl and an outline in red vinyl. 
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Before we talk about cutting vinyl, we have to make sure that the software is able to communicate with 

the plotter/cutter. This is done using the correct Driver, the correct Port, the correct Cable, and the 

correct Settings on the machine. TƘŜǊŜ ƛǎ ƻōǾƛƻǳǎƭȅ ŀ ƭƻǘ ǘƻ ǘƘƛǎΣ ǎƻ ǿŜ ǿƻƴΩǘ ŎƻǾŜǊ ƛǘ here, but please 

see the appendices at the end of this document titled Configuring Your Plotter or Cutter in Sign Wizard 

and How to Configure WPD Plotting.  

Once you have your machine correctly configured, there are a few options you can set prior to clicking 

on Plot, including setting the Material Height όǎƘƻǿƴ ƛƴ ǘƘƛǎ ŜȄŀƳǇƭŜ ŀǎ ннέύΣ ŀŘŘƛƴƎ Easy Weed lines, 

Step and Repeat, Rotation, Mirror , and more. You can also select the Color that you want to plot just by 

clicking on it in the Colors list. As you bring in files to the Plot Manager, they will be listed in the Jobs list. 

If you have a large job, you can return to the Layout Window as your job is cutting. 
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Import and Export  

Here is a table of the more common File Formats that you can import to and export from Sign Wizard 7. 

Format Type Import Export Comments 

PDF Raster +Vector Yes Yes Preferred format for import and export. 

EPS Vector Yes Yes Good format. 

AI Vector Yes Yes Good format. 

DXF Vector Yes Yes !ǾƻƛŘ άŜȄǇƭƻŘŜŘέ Řŀǘŀ ŦǊƻƳ !ǳǘƻ/!5Φ 

PLT Vector ς HPGL Yes Yes Watch out for large file sizes with chords. 

JPG Raster Yes Yes Common for photographs, web content. 

TIFF Raster Yes Yes Typically the highest quality raster format. 

PSD Raster Yes  Native Photoshop format. 

 

We realize that many customers do not know or care about the difference between a vector format and 

a raster format, and all of the subtleties that go with these formats and files. But it is important to know 

the difference and when a particular format is better than another. 

When you are importing artwork to be used in Sign Wizard 7, there are certain observations you should 

make and certain rules that must be followed to get the best results. 

The very first observation that you have to make is Do I have a vector file or a raster file? LŦ ƛǘ ƛǎƴΩǘ 

obvious by the format, go to the Color icon  in the toolbox on the left and click it. If the object 

disappears, and just a rectangle remains, then it is a raster file. If the vectors turn blue, red, and possibly 

ōƭŀŎƪΣ ǘƘŜƴ ȅƻǳ ƘŀǾŜ ŀ ǾŜŎǘƻǊ ŦƛƭŜΦ [ŜǘΩǎ ŎƻƴǘƛƴǳŜ ƻƴ ǘƘŜ ōŀǎƛǎ ǘƘŀǘ ȅƻǳ ƘŀǾŜ ŀ ǾŜŎǘƻǊ ŦƛƭŜ ŦƻǊ ƴƻǿΦ 

Loop Direction, Open and Closed Loops 

The colors of the vectors indicate Loop Direction and whether or not a loop is Open or Closed. This is 

very important, because an object that you are going to cut must have closed loops, and these loops 

must be in the correct direction. The outside loop must be blue, indicating a clockwise loop direction, 

and an inside loop must be red, indicating a counter-clockwise direction. An open loop is black, and 

must be closed prior to using many of the tools in the software. So the first step you want to take when 

analyzing an imported file is turn off the colors   and look at the colors of the loops. 
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If the loops in your design do not 

follow these rules, select the letters 

or logo and select Edit Menu | 

Reorder Loops. An alternate 

approach is to use the Combine 

function on the selection, which is in 

the Arrange Menu | Combine. This 

will create one object from all the 

loops that were in the selection, and 

reorder the loops at the same time. 

If you notice that a loop is black, then we have to do some 

additional investigation. We want to see what the individual 

vectors look like for the object, so click on the Vector Edit Tool  , 

which is the second tool on the left below the Layout Tool  . 

IŜǊŜ ƛǎ ǘƘŜ ά/έ ŦǊƻƳ ǘƘŜ ŀōƻǾŜ ŜȄŀƳǇƭŜΣ ǿƘƛŎƘ ƛǎ ŎƻƳǇǊƛǎŜŘ ƻŦ 

Bezier curves and a couple lines. You can see where the loop is 

open. The quick way to close this loop is to select Arrange Menu | 

Close All Loops. ¢Ƙƛǎ Ƴŀȅ ƴƻǘ ǿƻǊƪ ƛŦ ǘƘŜ ƎŀǇ ƛǎ ǘƻƻ ōƛƎΣ ǎƻΧ 

An alternate and more precise method is to manually close the 

loop. While in the Vector Edit Mode, just select the end point of 

the line where the loop is open, hold down SHIFT, and move the point over the end point of the Bezier 

curve. The program will click, and the two points will snap together. Just release the mouse and the 

points are now connected. 

2ÁÓÔÅÒ ÔÏ 6ÅÃÔÏÒ #ÏÎÖÅÒÓÉÏÎ ÁÎÄ Ȱ2ÁÓÔÅÒÉÚÅȱ 

Now that we have talked about vector files and raster files, and since merging these two kinds of files 

ǘƻƎŜǘƘŜǊ ƛƴ ŎƻƳǇŜƭƭƛƴƎ ǿŀȅǎ ƛǎ ŀƴ ƛƳǇƻǊǘŀƴǘ ǇŀǊǘ ƻŦ ǘƘŜ ǎƻŦǘǿŀǊŜΣ ƭŜǘΩǎ ǘŀƭƪ ŀōƻǳǘ ŎƻƴǾŜǊǘƛƴƎ ōŜǘǿŜŜƴ 

one format and the other. Converting a bitmap file into a vector file ƛǎ ǳǎǳŀƭƭȅ ŎŀƭƭŜŘ άwŀǎǘŜǊ ǘƻ ±ŜŎǘƻǊ 

/ƻƴǾŜǊǎƛƻƴέ ŀƴŘ ƛǎ ŜƛǘƘŜǊ ŘƻƴŜ ƛƴ {ƛƎƴ ²ƛȊŀǊŘ ǿƛǘƘ ǘƘŜ ŦǳƴŎǘƛƻƴ Vectorize or the function On-Screen 

Digitize. The choice will depend on the quality and characteristics of the file. If the file is good quality, 

with enough detail and contrast, then Vectorizing is preferred. If the file is poor quality, then On-Screen 
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Digitizing would be the preferred method. Converting a vector file into a bitmap file is usually called 

Rasterize. 

Vectorizing  

Vectorizing is an automated process that figures out where the vector path should go, based on the file 

and the input parameters. 

IŜǊŜ ƛǎ ŀ ōƛǘƳŀǇ ŦƛƭŜΣ ά!ǘƭŀƴǘƛŎ /ŜƴǘǊŜΦέ [ŜǘΩǎ ǎŀȅ ǘƘŀǘ ǿŜ ǿŀƴǘ ǘƻ ŎǊƻǇ ǘƘƛǎ Ƨǳǎǘ ǘƻ ά!¢[!b¢L/έ for 

Vectorizing. Take note of the vertical dimension before cropping. 

When you have a bitmap file selected, the toolbar changes to provide options for editing this kind of file. 

Among those options is Crop, highlighted here in yellow. When you click on this icon, you can then 

position the crop marks around what you want to keep in the file.  

 

 

Simply click on Apply and the Crop function will remove all data outside the crop lines. Now we can 

proceed with Vectorizing by clicking on the  icon. 

The Vectorize function has its own toolbar with various options for getting the best results from your file.  
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The first action is to use the Color Dropper cursor to select the colors that you want to vectorize. In this 

case it is just black, so position the color dropper over one of the letters and click. This will add the color 

to the color bar highlighted in the image above. If the graphic was multi-colored, then you would 

continue to add additional colors in this way. Please note that if you are vectorizing colors, they need to 

be spot colors with clear boundaries. You will not get good results trying to Color Vectorize graphics that 

contain color blends, photographs, etc. 

This particular file is monochromatic, contains mostly lines, and has a lot of pixel data, so we have 

chosen the options in the toolbar that will give the best results. For a complete discussion of each option, 

please consult the Online Help.  

Next click on Preview and the software will vectorize the file. The original image will be made slightly 

transparent, and the new vector version will be placed to the right of the original. You can now make 

additional changes to the settings and click on Preview again, or click on Done to finish the process. 

 

On-Screen Digitizing  

If the bitmap file you have imported is not a good quality file, and you do not think that the Vectorizing 

function will give clean results, then you have the option of On-Screen Digitizing the file. This involves 

placing arcs, lines, and/or Bezier curves over the bitmap to create the vector outlines. On-Screen 

Digitizing is very precise, and visually if you can see where the letter outlines should go, then this 

process can go quickly. 
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CƻǊ ǘƘƛǎ ŜȄŀƳǇƭŜΣ ƘŜǊŜ ŀǊŜ ŀ ŎƻǳǇƭŜ ƭŜǘǘŜǊǎ ŦǊƻƳ ǘƘŜ ά!¢[!b¢L/έ ŦƛƭŜ ǘƘŀǘ ƘŀǾŜ ōŜŜƴ ŜȄǇƻǊǘŜŘ ŀǘ ŀ ǾŜǊȅ 

low resolution, and then imported back into the software. Even though these letters are very jagged, we 

know that we can place straight lines and position the corners in the right place. 

The On-Screen Digitizing icon  is the third one down in the Toolbox along the left of the screen. 

When you are in this tool, there is a pop-up menu that provides the options for creating a vector path. 

 

The first step is to start a new vector path by clicking on the 

position of the start point. That will bring up the menu, where 

you select Start. Then move the mouse to the next point (in a 

clockwise direction for an outside loop, counter-clockwise 

direction for an inside loop) and click, this time selecting Line. 

Continue in this way around the letter until you get back to the 

Start point. Create your final vector and hold down SHIFT while 

you move the endpoint over the Start point. You will hear a 

άōŜŜǇέ ǎƻǳƴŘ ŀƴŘ ǘƘŜ ƭƻƻǇ ǿƛƭƭ ōŜ ŎƭƻǎŜŘΦ ¸ƻǳ ŎŀƴΣ ƻŦ ŎƻǳǊǎŜΣ 

select Arc, Tangent Arc, and Bezier Curve as options as well. 
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Online Help  

While this document ƛǎ ŘŜǘŀƛƭŜŘ ŀōƻǳǘ Ƴŀƴȅ ƻŦ ǘƘŜ ǇǊƻƎǊŀƳΩǎ ŦǳƴŎǘƛƻƴǎΣ ƛǘ ƛǎ ƴƻǘ ŀƴ ŜȄƘŀǳǎǘƛǾŜ ƎǳƛŘŜ ǘƻ 

everything in the software. Please get into the habit of accessing the documentation in the Online Help 

system, which you can do with the F1 key, or by pressing the Help button in dialog windows, or the  

icon in many of the property bars.  

 

We will now go through the new and improved features of Sign Wizard 7. 
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Paragraph Text Tool  

Advantage, Grand, Pro 

 

The new Paragraph Text Tool is a whole set of new features and capabilities designed to give you even 

more power with text. It is really a redesign of the text engine, opening up new doors for text-rich 

ŘŜǎƛƎƴǎ ŀƴŘ ƴŜǿ 5ȅƴŀƳƛŎ 9ŦŦŜŎǘǎΦ 9ǾŜƴ ƛƴ ǘƻŘŀȅΩǎ ƛƳŀƎŜ-rich sign market, text is still a vital part of the 

vast majority of your signs. 

 

You already know how well Sign Wizard works with text. Here is a quick summary of the new capabilities 

of Paragraph Text: 

 

- Three modes for entering text and managing the paragraphs 

- Control points for kerning and tracking, word spacing, line spacing 

- Easy justification of the entire paragraph: left, right, center, justified 

- Auto Weld of any overlapping sections in real time 

- Autonumbering and Bullets with one click 

- Menu Board feature for listing items with prices, justified left and right 

- Multiple columns with various options for spacing 

- Map to a Path, Map to a Circle, and Arc Text, all fully editable in various ways. 

- Real-time Spell Checker as you type 

- Paste large amounts of text from the Windows clipboard 

 

These will be explored in more detail below. 

 

There is a new menu called Paragraph that contains the new features, as well as a toolbar that will 

ŀǇǇŜŀǊ ǿƘŜƴ ȅƻǳ ŀǊŜ ƛƴ ǘƘŜ άtŀǊŀǘŜȄǘέ ƳƻŘŜΦ 
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 The traditional text entry mode is still available, and we now call it Basic Text. For small amounts of 

text, and text that will not have lots of Effects applied, Basic Text still works great. As you get used to the 

new mode, you can decide when to use which mode. 

 Paragraph Text mode can be entered with this icon in the toolbox on the left. When you click in the 

layout window, just type normally. There are three modes for the Paragraph Text Tool: 

 

1. Basic Mode (non-wrapping) ς just enter text and hit Enter for each new line. 

2. Simple Wrap Mode ς uses a control line below the text to set the width of the paragraph. No 

need to hit Enter for a new line. 

3. Frame Mode ς the paragraph text is constrained within a frame that can be adjusted at any time. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you enter some lines of text, you will be in the default Basic Mode, where the text does not wrap. 

Just press Enter for a new line. 

 

You will see two new control points that look like this , one at the lower right and one at the lower 

left of the paragraph. As you would guess, the one at the lower right controls the tracking, uniformly 

across all the lines of text. Holding SHIFT while moving this point will change the word spacing. The 

lower left point will change the Line Spacing, again evenly across all the lines in the paragraph. 
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In any of these modes, you have control over the justification ς left, middle, right, or justified ς by 

clicking on the appropriate icon in the toolbar. This may not seem too exciting yet, but keep reading, as 

it gets better. 

 

Welding of overlapping text characters and/or 

graphic elements has been a Sign Wizard 

feature for many years. But after welding a line 

ƻŦ ǘŜȄǘΣ ƛǘ Ƙŀǎ ŀƭǿŀȅǎ ƳŜŀƴǘ ǘƘŀǘ ȅƻǳ ŎŀƴΩǘ Ǝƻ 

back and change the font or change the 

ŎƻǇȅΧǳƴǘƛƭ ƴƻǿΦ  

 

With the new Auto Weld (Grand, Pro) with 

ParaText, you can adjust the kerning letter by 

letter, on a line of text, or the tracking on the whole paragraph, to create overlapping letters and it will 

Weld automatically. Then you can adjust the kerning and/or tracking again and it will re-weld. Then you 

can change the font, and it will maintain the kerning and/or tracking and re-weld if necessary. And you 

can change the copy and it will re-ǿŜƭŘΦ [ŀǘŜǊ ƻƴ ǿŜΩƭƭ ǘŀƭƪ ŀōƻǳǘ ǎƻƳŜ ƻŦ ǘƘŜ ƴŜǿ 9ŦŦŜŎǘǎΣ ǎǳŎƘ ŀǎ 

Dynamic Outline, Dynamic Shadow, Image Fills, and Bevel, and this Auto Weld will take on even more 

importance. 
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Paragraph Text also automates the formatting of lists and menu boards with a few new capabilities. 

[ŜǘΩǎ ǎŀȅ ȅƻǳ ƴŜŜŘ ǘƻ ƳŀƪŜ ŀ ƭƛǎǘƛƴƎ ƻŦ ƛǘŜƳǎ ŀǾŀƛƭŀōƭŜ ƻƴ ŀ ƳŜƴǳ ŦƻǊ ŀ ǊŜǎǘŀǳǊŀnt. You want the menu 

ƛǘŜƳǎ ƻƴ ǘƘŜ ƭŜŦǘ ŀƴŘ ǘƘŜ ǇǊƛŎŜǎ ƻƴ ǘƘŜ ǊƛƎƘǘΦ ¢ƻ ŜƴŀōƭŜ ǘƘƛǎ ƧǳǎǘƛŦƛŎŀǘƛƻƴ ƻƴ ōƻǘƘ ǎƛŘŜǎΣ Ƨǳǎǘ ǘȅǇŜ ά---ά 

between the item and the price. When you click on the Menu Board (Pro) icon , you will get this: 

 

Now say you want to add bullets  or make it a numbered list  

 

You can easily switch between the regular menu board, the bulleted list, and the numbered list with a 

click of the appropriate icon. This feature can be used for any design where you need justification on 

both sides. 

 

TƘŜ ƴŜȄǘ tŀǊŀƎǊŀǇƘ ¢ŜȄǘ ŦŜŀǘǳǊŜǎ ǿŜΩǊŜ ƎƻƛƴƎ ǘƻ ƭƻƻƪ ŀǘ ŀǊŜ Map to Circle (Pro) and Map to Path (Pro). 

These are dynamic features in the sense that you can always go back and change the font, change the 

copy, change the kerning or tracking, change the scale of either the text or the path/circle, or change the 

ǇŀǘƘ ƛǘǎŜƭŦΦ IŜǊŜ ƛǎ ǘƘŜ ŜȄŀƳǇƭŜ ǘŜȄǘ ǘƘŀǘ ǿŜΩǊŜ ƎƻƛƴƎ ǘƻ ǎǘŀǊǘ ǿƛǘƘΥ 
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The next step is to add a circle, with a size that will enable the text to wrap most of the way around it. 

Now we group the circle with the text and select Map Ą Map to Circle from the Paragraph Menu. 

 

If you have two lines of text, the top line will map 

to the top of the circle, and the bottom line will 

map to the bottom. If you have just one line, it will 

map to the top, but you can break the text into two 

lines and the second line will automatically map to 

the bottom. 

 

 

From here we have several options: change the 

size of the circle, change the size of the text, 

change the tracking, and change the space 

between the text and the circle (a negative space 

will place the letters inside the circle). If you change the tracking so that the letters are overlapping, and 

have Auto Weld on, then whatever subsequent changes you make, welding will be automatic. 

 

 

 

In this example, we changed the font, tracking, 

spacing on the top and bottom, and had Auto 

Weld turned on. 

 

 

Perhaps a more capable feature is Map to Path, 

since that path can be virtually anything. It can 

be a Bezier curve (or multiple Bezier curves), a 

vector graphic of some kind, a regular character, 

or a variety of other paths. 
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Taking the same text, with the proper punctuation added to make it a single line (which is a requirement 

for Fit to Path), we can now explore this feature. If you have a path that you want to map to, just make a 

group of the path and the text and then select Map Ą Map to Path (Pro) from the Paragraph Menu. If 

you do not have a path selected, then a default Bezier curve will be used. 

 

The path can be anything, really, but watch out for sharp/tight corners, as your individual letter spacing 

Ƴŀȅ ƘŀǾŜ ǘƻ ōŜ ŀŘƧǳǎǘŜŘΦ IŀǾƛƴƎ !ǳǘƻ ²ŜƭŘ ǘǳǊƴŜŘ ƻƴ ƛǎ ŀ ƎƻƻŘ ƛŘŜŀΗ IŜǊŜ ȅƻǳ Ŏŀƴ ǎŜŜ ǘƘŀǘ ǘƘŜ άƎƛŀƴǘ 

ƭŜŀǇ ŦƻǊ ƳŀƴƪƛƴŘέ ƛǎ ŀ ƭƛǘǘƭŜ ǘƛƎƘǘΦ ¢ƘŜ Ŝŀǎȅ ǎƻƭǳǘƛƻƴ ǿƛǘƘ tŀǊŀƎǊŀǇƘ ¢ŜȄǘ ƛǎ ǘƻ ǎŜƭŜŎǘ ǘƘŀǘ ǇƻǊǘƛƻƴ ƻŦ ǘƘŜ 

text and use the lower right tracking control point to add a little space between each letter. Problem 

solved. 

 

 

 

 

 

The path can also be a regular graphic, or in this case, a 

letter. On a closed loop, the path will begin at the Start/End 

point, so you can move the Start/End point if need be.  

 

Even in a case like this, you can always change the font, 

change the text, and change the letter spacing. And as with 

Fit to Circle, you can also change the size of the path (in this 

ŎŀǎŜ ǘƘŜ ƭŜǘǘŜǊ ά{έ ŀƴŘ ƻǊ ǘƘŜ ǎƛȊŜ ƻŦ ǘƘŜ text. 
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The new capabilities with Paragraph Text continue with Columns. When you are dealing with large 

amounts of text, it can make sense to place them in columns. Now there are several options for 

formatting multiple columns and spacing. When working with columns, you must be in the Frame Mode. 

The frame becomes the working area, and the various spacing options are based on that frame. For this 

example, we have simply taken the text in this and the above paragraph and copied and pasted it into 

the layouǘΦ ¢ƘŀǘΩǎ ŀ Ŧŀǎǘ ǿŀȅ ǘƻ ŜƴǘŜǊ ƭƻǘǎ ƻŦ ǘŜȄǘΦ 

 

Your initial text will look like this in the frame. To change this into two columns, just enter 2 in the 

columns box in the toolbar. The next box is for the center gap, then indent, then first line indent, then 

the last four on the right are for spacing from left, top, right, and bottom of the frame. 
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Live Spell Checking 

All Sign Wizard Levels  

 

Spell checking has become a standard feature for all authoring applications, as well as signmaking 

software. Now there is a mode that will instantly tell you if a word is misspelled. Live Spell Checking will 

work with both Basic Text and new Paragraph Text. 

 

The tool works in real time if you have Live Spell Checking selected in the Text menu. Just type in your 

text as shown below: 

 

The red underline will appear under any word the program is not able to find in its list of words. You 

ƘŀǾŜ ǘƘŜ ƻǇǘƛƻƴ ǘƻ ŦƛȄ ƛǘ ƛŦ ƛǘΩǎ ŀƴ ƻōǾƛƻǳǎ ŜǊǊƻǊΣ ƻǊ ȅƻǳ Ŏŀƴ Ǉǳƭƭ ǳǇ ŀ ƳŜƴǳ ƻŦ ǎǳƎƎŜǎǘŜŘ ǿƻǊŘǎ ōy holding 

CTRL while right clicking on the word. Then you can select from the list of similar words and it will 

replace the misspelled word with the new one. 

 

If the underlined word is not known to the dictionary, and it annoys you that it shows up as being 

misspelled, click on Add to Dictionary. 
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[ƛǾŜ {ǇŜƭƭ /ƘŜŎƪƛƴƎ Ŏŀƴ ōŜ ŀƴ ƛƳǇƻǊǘŀƴǘ ǘƛƳŜ ǎŀǾŜǊ ǿƘŜƴ ȅƻǳΩǊŜ ŜƴǘŜǊƛƴƎ ŀ ƭƻǘ ƻŦ ǘŜȄǘ ǳǎƛƴƎ ǘƘŜ ƴŜǿ 

Paragraph text tool. You can enter text as fast as you want and let the spell checker do its job after all 

the copy has been entered. Of course it will not check your grammar but it will let you know if you 

misspell grammer. 

 

Almost anyone who has been in the sign business very long has a few misspelled words to his credit. In 

the early 1950s William Knowland was running for re-election to the U.S. Senate in California. The 

election was just a few days away and he wanted a large bulletin board on a local highway to say       

Re - elect Senator Knowland . A local sign painter was given the details over the phone. He was told 

that he had the job if he could have it painted the next day. The sign was up on schedule but there was a 

problem. It said: 

  

RE-ELECT 

SENATOR NOLAN 

 

The sign painter was Riley Fassett, the first of the three generations of Fassett signmakers. He repainted 

the sign the following day. Senator Knowland was re-elected. Both Nolan and Knowland are proper 

ƴƻǳƴǎΣ ǎƻ {ƛƎƴ ²ƛȊŀǊŘΩǎ {ǇŜƭƭ /ƘŜŎƪŜǊ ǿƻǳƭŘ ƴƻǘ ƘŀǾŜ ǎŀǾŜŘ ǘƘŜ ŘŀȅΦ  

  



 Image Fills and Image Fills Library Manager он 

Image Fills and Image Fills Library Manager  

Pro 

 

Lƴ ǇǊŜǾƛƻǳǎ ǾŜǊǎƛƻƴǎ ƻŦ {ƛƎƴ ²ƛȊŀǊŘΣ ȅƻǳΩǾŜ ōŜŜƴ ŀōƭŜ ǘƻ Ŧƛƭƭ ǘŜȄǘ ŀƴŘ ƎǊŀǇƘƛŎǎ ǿƛǘƘ ƛƳŀƎŜǎΦ bƻǿ ǘƘƛǎ ƛǎ 

made much easier and much more powerful with the new Image Fills feature and associated Image Fills 

Library Manager. This is one of many features that combines the best of vector graphics with bitmap 

images. The vector outline contains the image, and both the vectors and the image can be edited 

independently with different tools. 

 

¢Ƙƛǎ ƛǎ ŀƭǎƻ ǘƘŜ ŦƛǊǎǘ ƻŦ ǘƘŜ ƴŜǿ 5ȅƴŀƳƛŎ 9ŦŦŜŎǘǎ ǘƘŀǘ ǿŜΩƭƭ ƭƻƻƪ ŀt, which deserves a little explanation. A 

Dynamic Effect is one where you can go back later and change the settings to rework the effect. Put 

ŀƴƻǘƘŜǊ ǿŀȅΣ ŀ 5ȅƴŀƳƛŎ 9ŦŦŜŎǘ Ƴŀƛƴǘŀƛƴǎ άǎǘŀǘŜΦέ {ƻ ŀǎ ȅƻǳ ŘŜǾŜƭƻǇ ȅƻǳǊ ŘŜǎƛƎƴ ŀƴŘ ȅƻǳ ǊŜŀƭƛȊŜ ǘƘŀǘ ȅƻǳ 

want to scale the Image Fill, or adjust the saturation, you can do it. Or perhaps you want to remove it 

altogether. 

 

Dynamic Effects also enable a term we brought up in the Introduction: non-linear design. The order of 

the steps in your design is far less important than it once was, because it is easy to make changes to the 

ƛƴƛǘƛŀƭ ŜƭŜƳŜƴǘǎ ƻŦ ǘƘŜ ŘŜǎƛƎƴΣ ǎǳŎƘ ŀǎ ǘƘŜ ǘŜȄǘ ƻǊ ŦƻƴǘΦ [ŀǘŜǊ ǿŜΩƭƭ ǘŀƭƪ ŀōƻǳǘ .ŜǾŜƭΣ 5ȅƴŀƳƛŎ hǳǘƭƛƴŜǎΣ 

Dynamic Shadows, Transparency, Blends, and more features that can be applied to text, perhaps even 

all together, without disabling the ability to change the text or font. 

 

{ƻ ōŀŎƪ ǘƻ ǘƘŜ LƳŀƎŜ Cƛƭƭǎ ŦŜŀǘǳǊŜΣ ǿŜΩǾŜ ŎǊŜŀǘŜŘ ŀ ǎȅǎǘŜƳ ǿƘŜǊŜ ȅƻǳ Ŏŀƴ ŀŘŘ ȅƻǳǊ 

ƻǿƴ ƛƳŀƎŜǎ ǘƻ ǘƘŜ ƛƳŀƎŜ Ŧƛƭƭ ƭƛōǊŀǊȅΣ ƛƴ ŀŘŘƛǘƛƻƴ ǘƻ ǘƘŜ ƻƴŜǎ ǿŜΩǾŜ ǇǊƻǾƛŘŜŘΦ ¢ƘŜ 

images are categorized so that you can quickly find the right image and you can also 

add new categories. The library comes with over 100 images to get you started. 

 

If your design is too big for the image to completely fill, it will automatically tile. You 

have the ability to move and scale the image to best fit your design. 
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To use Image Fills, select an object and go to the Effects Menu or use this icon  in the toolbox. The 

following toolbar will appear at the top of the screen. 

 

 

 

The left of the toolbar displays the images and the categories, and allows you to scroll through to choose 

the right image. When you have selected an image, it will fill the object as below. At this point you are 

free to move the image fill to position it in the best way for your object. As you do this, the Hs 

(Horizontal Shift) and Vs (Vertical Shift) numbers will update automatically. You can, of course, enter a 

numerical value in these boxes.  

 

 

You may also want to Scale the image up or down as well. The mouse wheel can be used for this ς just 

click on the Scale value. In fact, the mouse wheel can be used to adjust any of the parameters up or 

down, and your graphic will be updated in real time to reflect the changes. 

 

The other options in the toolbar are for brightness (positive values for brighter and negative values for 

darker), hue, saturation, and contrast. These are persistent values, meaning that if you come back into 

this feature again, the values that you originally set will be displayed. 

 

When using Paragraph Text with Image Fills, you have all the capabilities we described above, such as 

Auto Weld, Map to Path, etc. 
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Here are some additional examples:  

 

Gold leaf has long been a favorite technique of sign makers. Using a gold leaf fill on an outline, we can 

recreate this wonderful look: 
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Easy Bevel 

Pro 

 

[ŜǘΩǎ ŎƻƴǘƛƴǳŜ ƴƻǿ ǿƛǘƘ ŀƴƻǘƘŜǊ ƴŜǿ 9ŦŦŜŎǘ ǿƛǘƘ ƭƻǘǎ ƻŦ ǇƻǘŜƴǘƛŀƭ ŦƻǊ ȅƻǳǊ ǇǊƛƴǘŜŘ ŀƴŘ ǇǊƛƴǘκŎǳǘ ŘŜǎƛƎƴǎΥ 

Easy Bevel. A bevel is a highlight and a shadow that gives a 3D look to your text and graphics. The Easy 

Bevel feature has several options and settings that really give you control over how the final design 

looks.  

 

bƻǿ ǿŜ ƎŜǘ ǘƻ ǎǘŀǊǘ ŎƻƳōƛƴƛƴƎ ǘƘŜ ŜŦŦŜŎǘǎΣ ŀƴŘ ǿŜΩƭƭ ŎƻƴǘƛƴǳŜ ǿƛǘƘ ǘƘŀǘ ƛƴ ǘƘŜ ƴŜȄǘ ŦŜǿ ǎŜŎǘƛƻƴǎΦ !ǎ ȅƻǳ 

would guess, Sign Wizard 7 can add a bevel to your Image Fills, and you can still Auto Weld with bevel.  

 

As with Image Fills, you can go back and edit an existing Bevel. And finally, after you add a bevel, you can 

ŎƘŀƴƎŜ ǘƘŜ ǘŜȄǘ ƻǊ ŎƘŀƴƎŜ ǘƘŜ ŦƻƴǘΦ .ǳǘ ŦƛǊǎǘ ǿŜΩƭƭ Ǝƻ through the various options so you can see how the 

ōŜǾŜƭ ƭƻƻƪǎ ŀǎ ȅƻǳ ŎƘŀƴƎŜ ǘƘŜ ǎŜǘǘƛƴƎǎΦ ¢ƘŜ ƻǊƛƎƛƴŀƭ ŜȄŀƳǇƭŜ ƛǎ ǘƘƛǎ ǘŜȄǘ ά.ŜǾŜƭέ ƛƴ Dƛƭƭ {ŀƴǎ .ƻƭŘΥ 

 

 

The first setting is Inset, which will adjust how close the bevel is to the edge of the letter. The % is of the 

height of the letter. It may help to think of this as an Inline. The smaller the value, the closer the bevel 

will be to the edge of the letter, and the larger the value, the more the bevel will be inset from the edge. 

The next setting is Width, which refers to the width of the bevel itself. A smaller value will result in a 

smaller, more subtle bevel, while a larger value will be a larger, more pronounced bevel. See examples 

on the next page with these values higher and lower. 
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 Easy Bevel от 

Continuing on, the next setting is Softness, which is really the softness of the light. A low setting will give 

very hard edges between the highlight and the shadow, while a higher setting will give very soft edges. 

 

 

 

The last settings in this property bar are Highlight and Shadow. The examples given keep the values 

ŎƻƴǎƛǎǘŜƴǘΣ ōǳǘ ǘƘŜǊŜΩǎ ƴƻ ǊǳƭŜ ǘƘŀǘ ǎŀȅǎ ȅƻǳ ƘŀǾŜ ǘƻ Řƻ ǘƘŀǘΦ ! ƘƛƎƘŜǊ ǾŀƭǳŜ ŦƻǊ IƛƎƘƭƛƎƘǘ ǿƛƭƭ ƎƛǾŜ ȅƻǳ ŀ 

brighter highlight, and a higher value for shadow will give you a darker shadow. 100% highlight is pure 

white, 100% shadow is pure black. 

 

You can, however, change the highlight and shadow colors by clicking on the small color boxes beneath 

the highlight value, and then choosing a new color in the Color Tab. For example, you may want the 

highlight to be yellow, to indicate warm sunlight, or you may want the shadow to be a cool blue color. 

Or perhaps you want the highlights and shadows to simply be lighter and darker shades of the same 

color.  
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These are the basics for Bevel, but there are more advanced effects that you can create. For example, if 

you use a letter style with a consistent stroke width, you can easily create a rounded shape: 
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Or if you use a letter style that has thin strokes, or a connecting script like the example here, you can 

create more of a flat look. 

 

 

Bevel can be combined with Image Fills to give a three dimensional appearance to images:  

 

And to take this one step further, adding a Soft Shadow to a bevel gives it a very finished look. 
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Continuing on with additional ideas, a Bevel can be added to an outline, instead of, or in addition to, a 

ǊŜƎǳƭŀǊ ŦƻƴǘΦ ¢Ƙƛǎ ƛǎ ŀŎǘǳŀƭƭȅ ǳǎƛƴƎ ŀ {ƛƎƴ ²ƛȊŀǊŘ ƻǳǘƭƛƴŜ ŦƻƴǘΦ ²ŜΩƭƭ ƘŀǾŜ ƳǳŎƘ ƳƻǊŜ ŀōƻǳǘ hǳǘƭƛƴŜ 

ŎƻƳƛƴƎ ǳǇΧ 

 

 

 

 

 

 

 

Yet another option with Bevel is to combine it with Blends. 

 

You can now see how many options there are for Bevel, as well as adding some other effects in addition 

ǘƻ .ŜǾŜƭΦ ²ŜΩƭƭ ŎƻƴǘƛƴǳŜ ǘƻ ǎƘƻǿ ƳƻǊŜ ŎƻƳōƛƴŀǘƛƻƴǎ ƻŦ 9ŦŦŜŎǘǎ ƛƴ ǘƘŜ ǳǇŎƻƳƛƴƎ ǎŜŎǘƛƻƴǎΦ CƛƴŀƭƭȅΣ ƛƴ ŀ ŦŜǿ 

steps we have created a reflection of text with an Image Fill and Bevel. This design also uses 

Transparency for the reflection. 
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Dynamic Outline  

Grand, Pro 

 

Outline is another long-time Sign Wizard feature that has been given a major upgrade for version 7. 

Outlining iǎ ǎƻ ŎƻƳƳƻƴ ǘƘŀǘ ǿŜΩǾŜ ƳŀŘŜ ƛǘ ŀǎ Ŝŀǎȅ ŀǎ ǇƻǎǎƛōƭŜ ǘƻ ǳǎŜΦ 5ȅƴŀƳƛŎ hǳǘƭƛƴŜ ƳŜŀƴǎ ǘƘŀǘ ȅƻǳ 

can always go back and change the outline(s) as necessary and it will also automatically update if you 

change the path of a graphic or text. 

 

Dynamic Outline includes the ability to add up to three outlines, and you can determine the amount of 

the outline by a numerical value or as a percentage of the height (usually 1% - 5%). (If three outlines 

ŀǊŜƴΩǘ ŜƴƻǳƎƘΣ ȅƻǳ Ŏŀƴ ŀƭǿŀȅǎ ŀŘŘ ŀ {ǘǊƻƪŜΦύ ¢Ƙƛǎ ƴŜǿ ǘƻƻƭ ŀŘŘǎ ŀ ǇŜǊǎƛǎǘŜnt outline option, which 

means that no matter what else you do to change the path of a vector graphic, your outline remains 

updated, automatically. A great time-saver! 

 

Dynamic Outline automatically welds, along with the text if it is Paragraph Text. If you want the 

dynamically created outlines to be detached from the original object, then you can do this with the 

Detach command found in the Arrange Menu. When you select Dynamic Outline from the Effects Menu, 

the property bar will give you 1st, 2nd, and 3rd outline options, where you enter the amount and select 

the color of each outline. 
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If the outlines overlap, they will automatically be welded: bƻǿ ǿŜΩǊŜ ƎƻƛƴƎ ǘƻ ǎǘŀȅ ǿƛǘƘ ǘƘƛǎ ƛŘŜŀΣ ŀƴŘ 

add another element, which is to have the Glow on ŀƴ ƛƳŀƎŜΦ ¢ƻ ƳŀƪŜ ǘƘƛǎ ƭƻƻƪ ǊŜŀƭƛǎǘƛŎΣ ǿŜΩƭƭ ƳŀƴŀƎŜ 

the opacity so that the background image shows through. 

Now there is another way to create your outlines that is even easier and faster, and that is in the Color 

Tab on the right of the screen. This has been updated to include the main outlining capabilities. 

 

 

The top three icons here represent the 1st, 2nd, and 3rd outlines. When 

you have one selected, you may enter the value in the box (6% in this 

example). The mouse wheel can be used to change the value or the 

arrows can be clicked up or down. 

 

 

The middle icon in the second row will create an outline with a gap between the first and third outlines. 

The icon on the right of the second row deletes whichever outline is selected. There will be more 

discussion later about the new Color Tab. Now we can start to look at ways of combining Dynamic 

hǳǘƭƛƴŜ ǿƛǘƘ ǎƻƳŜ ƻŦ ǘƘŜ ǇǊŜǾƛƻǳǎ 9ŦŦŜŎǘǎ ǿŜΩǾŜ ƭƻƻƪŜŘ ŀǘΣ ƴŀƳŜƭȅ LƳŀƎŜ CƛƭƭǎΣ .ŜǾŜƭΣ ŀƴŘ !ǳǘƻ ²ŜƭŘΣ ŀǎ 

well as some old favorites, such as Soft Shadow, Blends, Transparency, and Feather. As you become 

more familiar with each of these, and how to combine them, the design power of Sign Wizard 7 starts to 

come through. 
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The first example here is placing an image Fill into one of the outlines. 

 

 

Since the outlines are dynamically created and 

ǳǇŘŀǘŜŘΣ ǘƘŜȅ ŀǊŜƴΩǘ ǎŜƭŜŎǘŀōƭŜ ƭƛƪŜ ƻǊŘƛƴŀǊȅ 

objects. In order to achieve an effect like this, 

you have to select the appropriate outline in 

the Layers Tab, and then apply the Image Fill. 

 

The next step with this design might be to add 

a Bevel to the outline or to the text. 

 

 

 

That really makes the letters pop. Just for fun we can also add a slight Blend to the lettering.  
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hƘ ƴƻΣ ǘƘŜ ŎƭƛŜƴǘ ŎŀƭƭŜŘ ŀƴŘ ǿŀƴǘǎ ǘƘŜ ǎƛƎƴ ǘƻ ǊŜŀŘ άCŜƴŎŜǎέ ƛƴǎǘŜŀŘΣ ǿƛǘƘ {ƻǳǾŜƴƛǊ aŜŘƛǳƳ ŀǎ ǘƘŜ ŦƻƴǘΣ 

and more spacing between the letters. Each change is one simple step. And if you do want to adjust the 

outlines, bevel, or blends, you can just open that tool again and make the appropriate changes. 

 

 
 

IŜǊŜΩǎ ŀƴ ŜȄŀƳǇƭŜ ƻŦ ŀƴ ƻǳǘƭƛƴŜ ŦƻƴǘΣ ǿƛǘƘ ŀƴ LƳŀƎŜ Cƛƭƭ, Bevel, an additional Outline, and then a Soft 

Shadow. 

 

With an outline font, the Soft Shadow will be seen inside the letters. It would be easy to create this 

same design with the letters a solid color and the shadow only on the outside of the letters. 
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The final item to note with Dynamic Outline is that if you want to vector edit one of the outlines, you 

must first detach the dynamic outline from the text or graphic. That means that any changes you make 

to the original item will not be reflected in the outline from that point forward. A good example of this 

would be if you wanted to create a large contour outline of a line of text. You might start with this: 

 

 
 

But you want the contour lines to be cleaner, straight across. So select the text and go to Detach from 

the Arrange Menu. Select the black outline and quickly vector edit to get this: 

 

At first glance, you may prefer the original, but this might be an intermediate step to this kind of design: 

 

 

We have been focusing almost exclusively so far on text, to get you used to the new Paragraph Text. But 

ƻŦ ŎƻǳǊǎŜ 5ȅƴŀƳƛŎ hǳǘƭƛƴŜΣ ŀǎ ǿŜƭƭ ŀǎ ǘƘŜ ƻǘƘŜǊ 9ŦŦŜŎǘǎ ǿŜΩǾŜ ŎƻǾŜǊŜŘ ǎƻ ŦŀǊΣ ǿƛƭƭ ŀƭǎƻ ǿƻǊƪ ǿƛǘƘ 

graphics. 
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Dynamic Shadow 

Grand, Pro 

 

Very similar to Dynamic Outline, there is also Dynamic Shadow, which will automatically be updated to 

reflect any changes you have made to the original text or graphic.  

 

aƻǎǘ ƻŦ ǘƘŜ 9ŦŦŜŎǘǎ ǿŜΩǾŜ ǘŀƭƪŜŘ ŀōƻǳǘ ǎƻ ŦŀǊ Ŏŀƴ ōŜ ŘƻƴŜ ƛƴ ŀƴȅ ƻǊŘŜǊΣ ǿƘƛŎƘ ƛǎ ǘƘŜ ŎƻƴŎŜǇǘ ƻŦ ƴƻƴ-

linear design. However, if you want to use Dynamic Outline and Dynamic Shadow together, it is best to 

add the outline first and the shadow second. 

 

When you select Dynamic Shadow for a line of text, this property bar is displayed at the top of the 

screen: 

 

 

 

The value for 1st refers to either an outline or a gap if you have Relief checked, as in this example. The X 

Shift and Y Shift indicate the position of the shadow. The small black square towards the right is the 

color of the shadow, and the last two icons indicate how the corners are drawn, squared off or rounded.  

 

When you are in the Shadow tool, you can move the shadow around to position it as you see fit, and the 

X and Y Shift values will update. This is all consistent with how Shadow has worked in the past.  
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²ƘŀǘΩs new with Shadow is the dynamic persistence of the values as you change the original object, as 

ǿŜƭƭ ŀǎ ǘƘŜ ŀōƛƭƛǘȅ ǘƻ ōŜ ŎƻƳōƛƴŜŘ ǿƛǘƘ ƻǘƘŜǊ ŜŦŦŜŎǘǎ ŀǎ ǿŜΩǾŜ ǎƘƻǿƴ ƛƴ ǘƘŜ Ƴŀƴȅ ŜȄŀƳǇƭŜǎ ǎƻ ŦŀǊΦ 

 

IŜǊŜΩǎ ǘƘŜ ǎŀƳŜ ŜȄŀƳǇƭŜ ǿƛǘƘ ǘƘŜ ǘŜȄǘ ǿŜƭŘŜŘΣ ŀƴŘ ŀƴ ƻǳǘƭƛƴŜ ǿƛǘƘ wŜƭƛŜŦ ǳƴŎƘŜŎƪŜŘΦ LŦ ȅƻǳΩǾŜ ōŜŜƴ 

reading this guide from the beginning, you know that at this point you can change the copy, change the 

font, and change the letter spacing with the shadow remaining consistent. 

 

Note: Dynamic Shadow does not work with Extruded Shadow, Perspective Shadow, or Cast Shadow. Soft 

Shadow, while listed as a different Effect, is also dynamic, but it is not new for version 7. 

 

Shadow can be an important feature for giving a printed design depth, especially when working with 

other features like Bevel and Outline.  
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As mentioned above, if you are going to use both Dynamic Outline and Dynamic Shadow together, 

which is a great idea, do the outline first and then add the shadow: 

 

¢ƘŀǘΩǎ ŀ ƭƻǘ ƻŦ ƻǳǘƭƛƴŜǎΣ ōǳǘ ƛǘ ǎƘƻǿǎ ŀ ŎƻǳǇƭŜ ƛmportant things. First, the shadow will be applied to the 

outside outline. Second, if in the Dynamic Shadow Effect you add an outline that goes around the 

outside as well, with the same color as the shadow itself. 

 

Another idea for Shadow that you may incorporate into your designs is to add Transparency to the 

shadow if you have text or graphics on top of an image. This example also Feathered the shadow (Soft 

Shadow could also be used to get the same effect). 
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Glow 

Pro 

 

Glow is another new Effect that will create more depth and separation with your printed designs. 

Somewhat similar to Soft Shadow, Glow radiates out in all directions, and falls off softly to create a nice 

ƭƛƎƘǘƛƴƎ ŜŦŦŜŎǘΦ ¸ƻǳ Ŏŀƴ ŎǊŜŀǘŜ ǘƘƛǎ άōŀŎƪƭƛƎƘǘέ ƭƻƻƪ ǿƛǘƘ Ƨǳst a few clicks, and there are some more 

ŀŘǾŀƴŎŜŘ ǘŜŎƘƴƛǉǳŜǎ ǘƘŀǘ ǿŜΩƭƭ ƭƻƻƪ ŀǘ ŀǎ ǿŜƭƭΦ 

 

The basic effect is best seen with a light colored glow on a darker colored background. This is not a 

shadow; it is a light that is spilling onto a surface. Think of a neon or LED channel letter open in the back. 

 

 

 

 

 

 

 

 

 

 

The options in the toolbar are Opacity, Softness, and Thickness, and you can choose a color for the glow. 

If we crank up the Softness and the Thickness, we get this: 
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Glow can also be used ƛƴ ŀ ǎƭƛƎƘǘƭȅ ŘƛŦŦŜǊŜƴǘ ǿŀȅ ǘƻ ǊŜŀƭƭȅ ŜƴƘŀƴŎŜ ǘƘŜ ŜŦŦŜŎǘΦ IŜǊŜΩǎ ǘŜȄǘ ǿƛǘƘ ŀƴ ƻǳǘƭƛƴŜ 

the same color as the glow (colors reversed from the previous example). 

 

 

 

 

 

 

 

 

 

Now if we Feather the outline, it creates this, which is kind of a double glow. 

 

 

 

 

 

 

 

 

 

²Ƙȅ ǎǘƻǇ ǘƘŜǊŜΚ IŜǊŜΩǎ ŀ ǘǊƛǇƭŜ ƻǳǘƭƛƴŜ CŜŀǘƘŜǊκDƭƻǿ ǿƛǘh multiple colors. 

 
 

 

 

 

 

 

 

 

Since this was starting to get tight, we increased the letter spacing a bit. 
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Now we are going to stay with this idea and add another element, which is to have the glow on an 

ƛƳŀƎŜΦ ¢ƻ ƳŀƪŜ ǘƘƛǎ ƭƻƻƪ ǊŜŀƭƛǎǘƛŎΣ ǿŜΩƭƭ ƳŀƴŀƎŜ ǘƘŜ ƻǇŀŎƛǘȅ ǎƻ ǘƘŀǘ ǘƘŜ ōŀŎƪƎǊƻǳƴŘ ƛƳŀƎŜ ǎƘƻǿǎ 

through. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
¢Ƙƛǎ ŘŜǎƛƎƴ ƛƴŎƭǳŘŜǎ ǎŜǾŜǊŀƭ ŎƻƴŎŜǇǘǎ ǘƘŀǘ ǿŜΩǾŜ ŎƻǾŜǊŜŘ ǎƻ ŦŀǊΣ ƛƴŎƭǳŘƛƴƎ .ŜǾŜƭΣ hǳǘƭƛƴŜΣ CŜŀǘƘŜǊΣ .ƭŜƴŘΣ 

ŀƴŘ DƭƻǿΦ IŜǊŜΩǎ ƻƴŜ Ŧƛƴal idea ς a double glow, inside and outside the letters.  
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Effects Library  

Pro 

 

So now you can do all these cool effects, combining them in interesting ways, experimenting with new 

ƛŘŜŀǎΦ ²ƻǳƭŘƴΩǘ ƛǘ ōŜ ƎǊŜat if you could save these and use them later on future designs? Not save them 

in layouts, but save them right in the software so that they are always available? Now you can with the 

Effects Library. This is one of the most powerful new features, not to mention a huge time saver! 

The Effects Library will save the following: 

Dynamic Outline 

Dynamic Shadow 

Image Fill 

Bevel 

Soft Shadow 

Feather 

Gradient 

Transparency 

Stroke 

Warp 

It will not save the font or the actual text used. 

[ŜǘΩǎ ǎŀȅ ǘƘŀǘ ȅƻǳ ƭƻǾŜ ǘƘŀǘ ŦƛǊǎǘ έWŀȊȊέ ŜȄŀƳǇƭŜ ŀƴŘ ǿŀƴǘ ǘƻ ǳǎŜ ƛǘ ŀƎŀƛƴΦ !ƭƭ ȅƻǳ ƘŀǾŜ ǘƻ Řƻ ƛǎ ǎŜƭŜŎǘ ǘƘŜ 

text, go to the Effects Tab on the right side, and click Add. The basic properties of the effects will be 

ǎŀǾŜŘΣ ŀƴŘ ŘƛǎǇƭŀȅŜŘ ƛƴ ǘƘŜ ƭƛǎǘ ǿƛǘƘ ŀƴ άŀΦέ 

When you are ready to apply one of the saved Effects to a line of text or object, just select the object 

ŀƴŘ ǘƘŜƴ ŘƻǳōƭŜ ŎƭƛŎƪ ƻƴ ǘƘŜ άŀέ ǘƘŀǘ ȅƻǳ ǿŀƴǘΦ LǘΩǎ ǘƘŀǘ ǎƛƳǇƭŜΦ LŦ ȅƻǳǊ ǎŜƭŜŎǘŜŘ ƻōƧŜŎǘ Ƙŀǎ ǎƻƳŜ 9ŦŦŜŎǘǎ 

already applied to it, then you have the option to Replace or Merge when you add the saved effects. 
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Replace will completely replace any effects already on the object, whereas Merge will only add any 

saved effects not present in the object, but not replace any that are present.  

For example, if your selected 

object has a Dynamic Shadow 

already, and your saved preset 

has both Gradient and Dynamic 

Shadow, then the Gradient will 

be added but the Shadow will 

not.   

 

 

 

 

 

 

 

Since you can probably imagine this list of saved Effects getting pretty large, there is a way to name and 

categorize them. If you right click over one of the presets, a menu comes up. At the bottom, it says 

Category, and if you move the mouse over that, another menu pops up allowing you to place the preset 

into an existing category or make a new one. 

Something eƭǎŜ ȅƻǳΩƭƭ ƴƻǘƛŎŜ ƛƴ ǘƘƛǎ ƳŜƴǳ ƛǎ ǘƘŀǘ ŜŀŎƘ ǇǊŜǎŜǘ ǿƛƭƭ 

show the Effects that are included, and if you put the mouse over 

one of those and click, then just that Effect will be added to your 

object. 

Have fun! This is a great way to impress your clients with your design 

capabilities 
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Brush, Clone Stamp, Background Eraser  

Pro for Clone and Eraser, Grand for Brush  

 

Now we are going to change gears a bit and focus on some tools for editing bitmap images. These are 

largely raster-based tools, as opposed to the primarily vector-ōŀǎŜŘ ǘƻƻƭǎ ǘƘŀǘ ǿŜΩǾŜ ŘƛǎŎǳǎǎŜŘ ǎƻ ŦŀǊΦ 

Sign Wizard 7 includes design features that integrate both types of files, giving you the best of both 

worlds. These three tools have been batched into the same section here because they are similar 

enough to describe together, and we can use one example to show them all. Each provides a way to add 

or subtract pixels in a bitmap, with options for Size, Opacity, and Hardness. 

The Brush Tool provides a way to paint color onto an image using your mouse. It includes several 

settings to fine tune how the brush effect looks, including the Size of the brush, the Opacity, the Flow, 

the Hardness, and of course, the Color. To use the Brush Tool, first select a bitmap and then click on the 

brush icon in the Bitmap Editing Toolbar:  

   This will bring up these options: 

 

The first thing to do is just get a feel for how the Brush Tool works with the various settings: 

Size ς the size of the brush in pixels. Obviously this relates to the size of the image in pixels, and how 

fine or large you want the brush strokes. 

Opacity ς determines how much coverage the brush stroke will provide over the background. A higher 

opacity value will paint over the background more thoroughly (100% opacity will completely replace the 

background with the selected brush color), and a lower opacity will have a much lesser effect (0% 

opacity wont do anything!).  

Flow ς ŘŜǘŜǊƳƛƴŜǎ Ƙƻǿ Ŧŀǎǘ ǘƘŜ ōǊǳǎƘ άƭŀȅǎ Řƻǿƴ ǘƘŜ ƛƴƪΦέ ¢Ƙis is different from Opacity in that you can 

go back and forth over the same area and add more coverage with Flow. 

Hardness ς refers to the hardness or softness of the brush edge. A high value will give a harder edge to 

the brush, while a lower value will give a very soft brush. 
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Here is our example image for this section, a beautiful tile mosaic welcoming tourists to Catalina Island.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

¢ƘŜ ŦƛǊǎǘ ǘƘƛƴƎ ǿŜΩƭƭ Řƻ ǿƛǘƘ .ǊǳǎƘ ƛǎ ŀŘŘ ǎƻƳŜ 

red color to the bricks. To choose the color for 

the brush, go to the Color Tab and select a 

medium-dark red color. 

By using a lower Opacity, 10% in this case, you 

can paint on the color without losing the texture 

of the bricks. If you use a higher Opacity in this 

case, you will just have red, without the brick 

texture.  
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Note that Opacity will be consistent as long as you hold down the mouse button. If you release and start 

again, you will be adding another 10%. 

bƻǿ ƭŜǘΩǎ ǎŀȅ ǘƘŀǘ ȅƻǳ ǿŀƴǘ ǘƻ ŎƘŀƴƎŜ ŀƴƻǘƘŜǊ ŎƻƭƻǊΣ ōǳǘ ȅƻǳ ǿŀƴǘ ǘƘŀǘ ŎƻƭƻǊ ǘƻ ŎƻƳŜ ŦǊƻƳ ǘƘŜ ƛƳŀƎŜ 

directly. Just click on the Color Sampling Tool from the Color tab and click on the color you want in the 

image. Now you can paint with that color, as in the green sail, sampled from the palm trees. 

 

 

 

 

 

 

 

 

 

¢ƘŜ ƭŀǎǘ ǘŀǎƪ ǿƛǘƘ .ǊǳǎƘ ƛǎ ǘƻ ǊŜƳƻǾŜ ǘƘŜ άǎƛƎƘǘǎŜŜƛƴƎέ ǘŜȄǘ ŦǊƻƳ ǘƘŜ ōŀŎƪƎǊƻǳƴŘΣ ŀǎ ƛǘ ǘŀƪŜǎ ŀǿŀȅ ŦǊƻƳ 

the main sign. In this case, we want the brush to have 100% Opacity to completely cover up that text, 

and we want to sample the color so that it looks natural. We can use a softer brush, maybe 50% 

Hardness to make it nice and smooth. 

 

 

 

 

 

 

 

 












































